
 

 
 

Free and Cheap Solutions for People with a 
Visual Impairment 

 

AbilityNet Factsheet – Championing IT for People With Disabilities 
AbilityNet is a registered charity, No. 1067673.  Telephone 0800 269 545 – Email: enquiries@abilitynet.org.uk – Web: www.AbilityNet.org.uk  

This factsheet is concerned with configuring Windows 95, 98, ME 
and NT and the software available that might be helpful to 
someone with a visual impairment that is either free or costs very 
little.  All items mentioned in this factsheet are free unless 
otherwise stated. 
 
There are many ways that Windows and some of the more popular 
programs can be altered to improve visibility for people with a 
visual impairment or simply for your own personal preference.  
Let's start with explaining some of these. 
 

Screen resolution 
Ensuring that your screen resolution (how small the dots are that 
make up the picture on your monitor) is no higher than 800x600 is 
a good starting point – text and pictures will be larger than at 
higher resolutions.  In Windows 95/98/ME/NT choosing 640x480 
can cause problems with portions of more complex message 
boxes being lost off the side of the screen.   
 
You may well be working at a resolution of 1024x768 by default.  
This can be changed within the Display options in the Windows 
Control Panel (“Settings” page).  Changing the resolution can be 
tricky so give us a call if you don’t know how to do it and we’ll go 
through it with you. 
 

System fonts 
It is possible to increase the size of all text within Windows 
(including icon text, menus, message boxes etc).  This can 
considerably enhance the visibility of Windows and all the 
programs you use. 
 
On the same page as the option to change the screen resolution is 
a button labelled “Advanced”.  Clicking this brings up a page on 
which you can increase the size of Windows’ standard text by up to 
200%.  At lower screen resolutions (i.e. 800x600), however, there 
is a limit to how much you can do this before things start to “fall off 
the screen” (similar to what happens at a screen resolution of 
640x480). 
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If your screen resolution is 800x600 then the maximum you can 
choose is 125%. 
 

Increasing the size of the mouse pointer 
It is possible to increase the size, and change the colour, of the 
arrow and the other shapes the mouse pointer appears as. 
 
First pull up the start menu with the Windows Logo key or by 
clicking on the Start Button.  Then select Settings and then Control 
Panel from the sub-menu with the arrow keys and pressing Enter. 
 
Open the item called Mouse by double clicking or moving the 
highlight with the arrow keys and pressing Enter.  Bring the 
Pointers page to the front by clicking on the tab or pressing 
Control+Tab. 
 
You can now arrow up and down through the standard pointer 
schemes.  
 
There is one called "Windows Standard Large".  You may or may 
not see "Windows Standard Extra Large" depending on your 
installation.  If you do not, check on your Windows CD or give us a 
call for more information. 
 
The "Windows Standard Inverted" schemes make the pointer white 
over a black background and black over a white background.  For 
even larger pointers a third-party piece of software is required.  
See below. 
 
The mouse pointer changes shape when it is over different things 
on the screen.  For example, when it is over the document window 
it is a thin "I-beam" that might be difficult to see.  It is possible to 
assign a more visible shape, such as the arrow, to make the 
pointer easier to see at these times.  The "Large" and "Extra 
Large" pointer schemes have the larger arrow assigned to all 
instances where pointers are more difficult to see. 
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Changing the Windows colour schemes 
Open the Control Panel as before and then open the Accessibility 
item by double clicking or moving the highlight with the arrow keys 
and pressing Enter.  Bring the Display page to the front by clicking 
on the tab or pressing Control+Tab twice.  
 
Now click the check box next to "Use High Contrast" or tab once 
and press the spacebar for the same result.  Click on the High 
Contrast Settings button or tab again and press spacebar.  
 
A dialog box appears that allows you to choose the high contrast 
colour scheme of your choice.  These are predominantly white text 
on a black background or black text on a white background.  Click 
on your choice or tab once and arrow up and down.  
 
To increase the sizes of fonts used by Windows in menus, buttons 
and some dialog and message boxes, choose the Custom option 
and tab again to the box in which you can arrow through schemes 
that include the words "large" or "extra large" next to them which 
indicate that they will affect the size of the text.  Please note, 
however, that increasing text sizes in this way leaves some more 
complex message boxes unaffected, whereas doing the same by 
increasing your system fonts (see section above) does not have 
this limitation. 
 
These pre-defined colour schemes can also be used as a starting 
point for your preferred combination of colours and text sizes.  
Each screen element may be changed and the new colour scheme 
saved under a new name. 
 

Customising the colour schemes 
Open the Control Panel as before and then open the Display item 
by double clicking or moving the highlight with the arrow keys and 
pressing Enter.  Bring the Appearance page to the front by clicking 
on the tab or pressing Control+Tab twice. 
 
This page contains a snapshot of a sample Windows screen and 
below a bar listing the currently selected `colour scheme'. 
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(a) Select one of the pre-defined colour schemes 
To change to a new scheme, click the mouse on the `colour 
scheme' box and press the up and down arrow keys.  When the 
snapshot looks good press the enter key to select it.  Some of 
these "High Contrast" schemes include contrasting colours and 
larger fonts. 
 
(b) Create a new colour scheme 
Select one of the pre-defined schemes as a basis for your own as 
above.  
 
Choose the item you wish to change by clicking on a particular 
element in the snapshot window or by tabbing three times to get to 
the “item box” and then moving up and down through the selection 
with the arrow keys. 
 
You can change the foreground (text) and background colours of 
each item by clicking on the coloured block (bottom right) or 
pressing Tab until highlighted and pressing Enter. A colour palette 
will appear and you can click on or arrow around and press Enter 
on the desired colour. 
To save changes click or Tab to and press Enter on the "Save 
As..." button, give it a name and press Enter.  To see how your 
changes will look when applied click on the "Apply" button or press 
Alt+A. 
 
To close the dialog box completely click or Tab to and press Enter 
on the "OK" button. 
 

The Windows 98/ME magnifier 
Windows 98 and Windows ME have a utility that can enlarge part 
of the screen.  If it is not to be found in the Start menu, under 
"Programs", then "Accessories" and finally "Accessibility" and 
called "Magnifier" then it will need to be installed from your 
Windows CD. 
 
When running there appears at the top of the screen a window that 
shows a magnified area of the lower screen.  It will follow whatever 
is moving (although there are bugs that mean that it won't track as 
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you type in MS Word and perhaps other packages too).  Whenever 
the mouse is moved it will follow the pointer to include that part of 
the screen in the magnified window. 
 
Microsoft's Magnifier is really only useful as a backup for those 
who can see the larger of the fonts in the "High Contrast" colour 
schemes but who have difficulty reading certain dialog boxes (like 
the "Open File" dialog) that are unaffected by the larger font 
changes. 
 

Microsoft Word and Excel features 
Both Microsoft Word and Excel have features that may help 
increase visibility. 
 
In Word you can make the document window white text on a blue 
background regardless of Windows' colour scheme.  Click on the 
Tools menu or press 'Alt+T'. Click on Options or press 'O'.  Click 
on the General tab or press control+Tab until it is on top.  Click on 
the check box next to "blue background, white text" or press 
'Alt+U'. 
 
To increase the size of the buttons in the toolbars in Excel and 
Word open the View menu by clicking on it or with Alt+V. 
Click on Toolbars or press 'T'. Click on Customize or press 'C'.  
A dialog box will appear in which you can select the Options tab 
and then select the "Large icons" check box or press 'L'. 
 
It should be noted that all functions performed by the toolbar 
buttons can also be accessed with hot-keys or from the pull-down 
menus.  For a full list of keyboard alternatives please contact us. 
 

The "zoom" facility 
Click on the View menu or pull down with Alt+V.  The bottom item 
is "Zoom".  In this dialog box you can adjust the amount of 
"zooming in" which makes the text in the document appear larger 
(only fitting part of the length of a line on the screen at any time) 
without affecting how it is printed out. 
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Arrow up to select "200%" (this is the maximum) or press Tab once 
and type in a value between 100 and 200.  Press enter to accept. 
 
If you do not like having a certain part of each line obscured as you 
type at a higher zoom than 100%, then you can check the "Wrap to 
Window" option in the "View" page of the "Options" dialog box. 
 
Press Alt+T to pull down the “Tools Menu”.  The bottom item is 
“Options”.  Select this to open the “Options” dialog box.  Press 
Control+Tab until the “View” page is on top ad then Alt+W to check 
the “Wrap to Window” option. 
 
If you have a wheel mouse you can access the zoom feature 
quickly by holding down the control key at the same time as rolling 
the wheel. 
 

Configuring your web-browser 
Many PCs running Windows come with Internet browsing software 
already installed.  Many websites are visually complex and 
confusing with multiple columns and text in strange combinations 
of colours.  All of the most common browsers, including Microsoft 
Internet Explorer and Netscape Navigator, can force the text to be 
of the size and colour you prefer, and the background and 
foreground colours of the page whatever combination you wish. 
 
For help in configuring your web browser for easier access to the 
world-wide-web please give us a call. 
Now let's look at some software and hardware that is either free or 
costs very little. 
 

Mouse pointer enhancement 
As well as the changes that can be made to the appearance of the 
mouse pointer (arrow) within Windows, there are many little utilities 
that can make it any number of exotic shapes, colours and sizes. 
As well as including such features as mouse trails and radar-style 
aids to finding the pointer on the screen. 
For further information on which mouse pointer utilities are 
available contact us or download the Microsoft "IntelliPoint" mouse 
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driver from www.microsoft.com/enable (search using the keyword 
“intellimouse”) or visit www.shareware.com and search for "mouse 
pointers". 
 

Finding the text cursor 
Many people find it difficult to locate the blinking vertical bar that 
indicates where you are typing in a word processor. 
 
There is no way of increasing the size, or enhancing the 
appearance, of this cursor except in Windows ME (and then it's 
size only increases in MS Word and a few other programs).  A 
small program called "follow.exe" can be obtained from us free of 
charge that makes the mouse pointer (that can itself be enhanced 
for easy visibility - see previous section) follow the blinking cursor 
as it moves.  This makes the blinking text cursor easy to see where 
it is at any time. 
 

Magnification software 
Magnification software enlarges the image on the screen up to 32 
times and tracks whatever moves to compensate for the fact that 
the whole screen content is not visible at any one time. 
Magnification software is quite expensive but necessary for those 
with significant vision problems. 
 
For Windows 3.11 there is a program called "Lunar Lite" that offers 
all such functionality and is free to download from the supplier's 
website at www.dolphinuk.co.uk and then clicking on the 
"Download" link. 
 
For Windows 95/98/ME/NT there are no such freeware programs.  
There are, however, some utilities that offer partial screen 
magnification and that could still be useful .  One such program is 
the Magnifier in Windows 98/ME (see above). 
 
Another package is the Microsoft "Intellipoint" mouse driver that is 
compatible with all Microsoft mice.  This driver has several features 
including mouse trails (a trail of arrows that fade away behind the 
pointer as you move around the screen) and a magnifying lens 
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(Windows 3.1 only).  This lens is a small rectangle whose contents 
is a magnified version of whatever is around the mouse pointer.  It 
is downloadable from www.microsoft.com/enable (search using the 
keyword “intellimouse”) 
 
"Loupe" (Windows 95/98/ME/NT) is a similar program available 
from us free of charge.  It can be used with any mouse and has the 
same lens capability as the Microsoft Intellipoint driver. 
 
"Magnifier" costs £35 from Keytools (Tel: 02380 584314) and has 
a similar, but resizeable, lens.  It also has a cross-hairs feature 
with horizontal and vertical lines that intersect at the mouse 
pointer.  The lines can be set thin, medium or thick for visibility, 
and can be animated, moving towards the pointer from each end of 
each line. 
 
BigShot is a full screen magnification package that can magnify in 
steps of 5% from 100% to 200%, as well as being able to invert 
screen colours.  It costs £75 from Sight & Sound (Tel: 01604 
798070). 
 

Keyboard stickers 
A set of large-character keyboard stickers can be purchased from 
Dolphin Computer Access (Tel: 01905 754577) at a cost of £15 in 
a range of foreground and background colours.  Simply stick these 
on the existing keys to improve visibility. 
 

Text-to-speech software 
There are several programs available that enable blocks of text 
within a word-processor document, for example, to be read back 
with synthesized speech output. 
 
One such program is called "ReadPlease 2003" and is available 
for free download from www.readplease.com, at a size of around 
11Mb.  It enables any highlighted text to be read back, with a clear 
interface and user-friendly controls. 
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Screen-reading software 
For those who need to rely entirely on speech or braille output to 
use their computer they require a screen-reading program.  
Screen-readers for Windows are quite expensive (typically around 
£600). 
 
A screen-reader, called "Hal Light", is available for DOS free of 
charge.  It requires a synthesiser called an Apollo 2, which costs 
£310 in its cheapest form (an internal card) but is often available 
for sale second-hand in publications such as the RNIB's "New 
Beacon".  Hal Light is available for download from 
www.dolphinuk.co.uk or from us on disk. 
 
Another free DOS screen-reader is Jaws for DOS, which also 
requires a hardware synthesiser such as the Apollo, and is 
available for download from www.hj.com. 
 

Internet access 
There are several web browsers that offer speech and/or large 
character output.  One of these is IBM's "Home Page Reader".  It 
includes enlarged text and e-mail and gives excellent access to 
even the trickiest web page.   
 
It is available from IBM from £80, tel: 0800 169 1458, 
www.ibm.com/uk or from Soundlinks at a cost of £125; SoundLinks 
Ltd (Tel: 0845 666 2849), www.soundlinks.com. 
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